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Introduction

The Department of Commerce (Commerce) is responsible for conducting
antidumping/countervailing duty (AD/CVD) investigations and reviews to determine
whether and to what degree merchandise is being sold at unfair prices in the United
States or whether grants are being paid by a foreign country to a manufacturer,
producer or exporter of merchandise to the U.S.

There are three government agencies involved in the investigation, review and
collection of anti-dumping and countervailing duties. Commerce and the
International Trade Commission investigate whether dumping or subsidies exist and
whether injury has occurred. Based on findings, Commerce instructs U.S. Customs
and Border Protection (CBP) on when to begin suspending entry summaries and
specifies bonding requirements and assessments on anti-dumping and
countervailing duties.

Searching for an AD/CVD Case

An AD/CVD case is an electronic reference file used to validate in-bound entry
summary transactions. A case is created upon initiation of an AD/CVD investigation
based on the company and country under investigation. The case information is
maintained electronically to reflect case and company specific information, including
milestone dates and cash deposit rates.

All users will be able to search for and display an AD/CVD case. Numerous filters
are available to aid in searching for a case. Please note filters are not case sensitive.
AD/CVD case information is located under the “References” tab in the ACE portal.

Home | Accounts References Tools ‘
|

To search for an AD/CVD case:
1. Select the References tab
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- AD/CVD Messages Search -
Mezzage Details -

2. Select AD/CVD Cases Search in the “Task Selector” portlet. The “Search
AD/CVD Cases” portlet displays.

3. Enter at least two search criteria in the “Search AD/CVD Cases” portlet.
To search for an AD/CVD case when the case number is not known, you
must enter at least two of the following criteria:

o “Case #". Enter the case number or at least four alphanumeric
characters followed by an asterisk (*), e.g., A580* to perform a
wildcard search using an abbreviated case number. Dashes do not
need to be included.

e “Country”: Select the ISO country and country name from the drop
down menu.

e “HTS #": Enter the 10 digit Harmonized Tariff Schedule (HTS) number
or at least four digits of the HTS number followed by an asterisk to
perform a wildcard search, e.g., 9403*.

o “Party Name”: Enter the party name or at least four characters of the
manufacturer or exporter name to perform a search. No wildcard is
required.

o “Party ID”: Enter the party ID for the manufacturer or the exporter or
perform a wildcard search by entering a minimum of four characters
followed by an asterisk.

e “Company Status”: Select a company status (“Active” or “Inactive”)
from the drop down menu.

e “Short Description”: Enter a description of up to a maximum of 30
characters or enter at least four characters of the description to
perform a search. Any keyword matching the short description will
return results. No wildcard is required.
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0

Search AD/CVD Cases ?T =

Search AD/CVD Case
Case #: Company Status: | ..Sa|act-- w |

Country: --Select-- .“’J Short Description:
HTS &:

Party Name:

Party ID:

Search

“ If you know the AD/CVD Case number, no additional criteria is required
A to execute the search.
—

4. Enter your search criteria and select the Search button. The results are
displayed at the bottom of the portlet, sorted alphanumerically by case
number. If the search fails to display the intended results, select the Clear
button and redefine your search criteria.

5. The following information is displayed for the case:

e “Case #’: The company case number.

e “Status” The status of the case (“Active” or “Inactive”).

e “Rel Case #": The related case indicator (“Yes” or “No”). If there is a
related case, select Yes to view its details.

o “Short Description”: The brief description of the case.

e “Cntry”: The country code - Select the Country Code hyperlink to
view additional information about the country.

o “Party Name”: The name and type of party, such as “manufacturer” or

“‘exporter.”
There are ten cases displayed out of a total The Up (A ) and Down (V) arrows next
of 323. In this view only 10 cases will be to each label are used to sort the list in
displayed on the screen. ascending or descending order.
/
Search Results / /
Showing 1 - 10 of 323
H Status Rel Case & Short Description Cntry Party Name
Active No Small Diameter CN
acive o Small Diameter S e Qi Corhr Tooh G L4
Active No Small Diameter cN E‘;;_"_:_?;:’T: ;E:l;::a[b:r Co., Ltd.
Active No Wooden Bedroom Furniture CN
Active No Wooden Badroom Furniture CN E‘:;'_TE';‘?IZQF&SI?L'I}:E?}‘C.
save Mo Wooden Sedroom Fumiure g B Shehr Iodumnas e,
Active No Wooden Badroom Furniture CN Mfr = Hengshui Kunxin Furniture, Ltd.
Active No Wooden Bedroom Furniture CN Mfr - Cheng Guangming Creations Furniture Co., Ltd.
Artive No Wooden Badroam Furmitiure o | Mir - Fuyao Hongfeng Furniture Co., Ltd.
Active No Wooden Bedroom Furniture cN Mir - Hualing Xinyuan Woodwork Co. Ltd.

(112345628310 1012 13124151647 181920 > >>
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The horizontal arrows and page numbers (<< <[1] 2 3 > >>) allow the user to navigate
between pages. To go to the first or last page of the list, select the double backward
arrows (<<) or double forward arrows (>>). Selecting the single arrows advances the
user forward (>) or backward (<) a single page at a time. The user can also select a page
number ([1] 2 3) to go directly to that page, if it is displayed.

6. Select the Case # of the case you want to view. The “View AD/CVD
Company” portlet displays with details about the selected case.

View ADJCVD Company 7T = [
Company Header DOC-TA Contact

Case #: A-570-890-001 Contact Office: Group 3, Office 9

Create Date: 10/20/2009 Contact Name: Customs Unit

Related Case #: Contact Telephone #1: 202-432-0984 Ext:

Country: CN - CHINAMAINLAND Contact Telephone #2: 202-432-3577 Ext:

Short Description: Wooden Bedroom Furniture
View Official Case Name

Status: Active

Suspend ES: Yes

Rates Events B/C AR Parties HIS? SuspES

= Print Wisw

Showing 1 - B of 8

Eff Date B eI O UOM Description Added Date L
09/01/2008 216.00% 11/05/2009

11/07/2007 216.01% 10/20/2009

08/22/2007 216.01% 10/20/2008

11/20/2006 15.78% 10/20/2009

01/04/2005 15.78% 10/20/2009

11/17/2004 15.24% 10/20/2009

08/05/2004 30.52% 10/20/2009

06/24/2004 24.34% 10/20/2009

7. The “View AD/CVD Company” portlet is divided into: the “Company Header”
section, the “DOC-IA Contact” section and the sub-tabs.
8. “Company Header” fields are as follows:
e “Case #". The company case number.
o “Create Date”. The date the company case was created.
o “Related Case #": The related case number. If there is a related case,
the 10 digit company case number will display.
e “Country”: The International Standards Organization country code
and name.
o “Short Description”: The short description of the case.
o “View Official Case Name”: The detailed description of the case.
Select this hyperlink to navigate to the “View AD/CVD Company
Case” portlet.
e “Status”: The status of the company case (“Active” or “Inactive”).
e “Suspend ES”: Indicates whether the entry summaries are currently
suspended (“Yes” or “No”).
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o A "Print View” hyperlink is also available with the option to save or
print. See the section in this document titled, “Printing an AD/CVD
Case.”

View AD/CVD Company

Company Header

Case #: A-580-601-002

Create Date: 05/15/2009

Related Case #: C-580-602-001

Country: KR - KOREA, REPUBLIC OF

Short Description: STAINLESS STEEL COOKING WARE
View Official Case Name

Status: Active

Suspend ES: Yes

Select the Related Case # hyperlink (if applicable) to view
information on related AD/CVD cases. To return to the “Company
Header” portlet, select the AD/CVD Cases Search hyperlink in the
“Task Selector” portlet.

Task Selector 2 | view AD/CVD Company

*{|company Header DOC-IA Contact
Hrs Case #: A-580-601-000 Contact Office:
Tariff Higtory Create Date: 08/15/2009 Contact Name: Customs Unit
Eort Related Case #: £-580-602-000 Contact Telephone #1: 202-432-0984 Ext:
Gold Rate Country: KR - KOREA, REPUBLIC OF Contact Telephone #2: 202-432-3577 Ext:
Currency Exchange Short Description: STAINLESS STEEL COOKING WARE
Country Code View Official Case Name
MID Status: Active
UN Loc Code Suspend ES: Yes
AD/CVD Cases Search -
> Company Details "l Rates Events B/C AR Parties HIS# Susp ES
Messages ;
AD/CVD Mass Search 4 & Print View
Showing 1 - 6 of 6
Eff Date Ad valorem Specific jny UOM Description Added Date Inactivated
Rate Rate Date
08/29/2001 8.10% 09/15/2009
03/08/1994 7.35% 09/15/2009
09/27/1993 8.10% 09/15/2009
08/12/1991 1.69% 09/15/2009
03/05/1991 2.02% 09/15/2009
01/20/1987 8.10% 09/15/2009

Select the Country hyperlink in the “Company Header” portlet to
view information on the country. To return to the “Company Header”
portlet, select the AD/CVD Cases Search hyperlink in the “Task
Selector” portlet.
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Lookup Country Code

Country: | CHINA{MAINLAND) CN v

Search Results

Country Code Information

Country Name: CHINA[MAIMLAND) 150 Code: Ch
Customs Country Code: 5700

Indicators
Rate Column Indicator: 1 SPI Indicator:

Restriction Indicator: Mo AGOA CBPTA Indicator:
AGOA LDD Indicator: Mo
GSP Information

GSP Code: Mo GSP End Date:
GSP Start Date:

Drawback Eligibility
Drawback Eligible: Ho

Select the View Official Case Name hyperlink to view the official
case name. To return to the Company Header portlet, select the
Back button.

View AD/CVD Company Case

Official Case Name

Case #: A-570-991-001

Short Description: Wooden Bedroom Furmiture

Official Case Name: Wooden bedroom furniture is generally, but not exclusively, designed, manufactured,
and offered for sale in coordinated groups, or bedrooms.

)

9. “DOC-IA Contact” fields display information associated with the Import
Administration along with a phone number for inquiries or requests for
information.

DOC-IA Contact
Contact Office: Group 3, Office 9
Contact Name: Customs Unit
Contact Telephone #1: 202-432-09834 Ext:
Contact Telephone #32: 202-482-3577 Ext:

Seven sub-tabs are displayed for the AD/CVD company case: “Rates,” “Events,”
“B/C,” “AR,” “Parties,” “HTS #” and “Susp ES.”
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Rates Events B/C AR Parties HTS # Susp ES
=D Print View
Showing 1 - 4 of 4

Ad valorem Specific
Eff Date Rate Rate

UoM UOM Description Added Date l‘;::z""‘“e"
06/17/1597 66.65% 09/15/2008
11/07/1990 13.76% 09/15/2009
10/10/1986 66.65% 09/15/2009
05/20/1986 51.38% 09/15/2009

10. Select the Rates sub-tab to view the deposit rates. Deposit rates are used to
calculate estimated anti-dumping and countervailing duties. Deposit rates
can be added with an effective date in the past, in the future or the current
date. Multiple rates can be entered for the same effective date. Users have a
complete history for determining the rate used in the duty calculation. The
“‘Rates” sub-tab displays the following information:

« “Eff Date”: The effective date of the rate.

e “Ad Valorem Rate”: The Ad Valorem percentage rate.

o “Specific Rate”: The specific rate in dollars.

e “UOM”: The unit of measure for the rate.

e “UOM Description”: The full description of the unit of measure.

e “Added Date”: The date when the rate was added.

« ‘“Inactivated Date”: The date when the rate was inactivated.

o A “Print View” hyperlink is also available with the option to save or
print. See the section in this document title, “Printing an AD/CVD
Case.”

11.Select the Events sub-tab to view a chronological list of all the events that
occur throughout the lifecycle of an AD/CVD Case, including any
determinations associated with the event. The “Events” sub-tab displays the
different milestones within the lifecycle of a case (“Initiation,” “Preliminary,”
‘Final,” “Order,” “Terminated,” etc.)

« “Eff Date”: The effective date of the event.

« “Event™ The type of event associated with the case.

« “Determination”: The determinations associated with the event
(“Affirmative” or “Negative”) based on the result of an investigation by
the International Trade Commission and Commerce.

« “FR Cite”: The Federal Register Notice cite associated with the event.

e “Added Date”: The date when the event was added.

« ‘“Inactivated Date”: The date when the event was inactivated.

Providing the Right Information to the Right People at the Right Time and Place
7 February 2012



Topic: AD/CVD Cases & Messages

o A "Print View” hyperlink is also available with the option to save or
print. See the section in this document titled, “Printing an AD/CVD
Case.”

Rates Events B/C AR Parties HIS# SuspES

3 Print View

Eff Date Event Determination FR Cite Added Date :]'::“"“‘d
01/04/2005 Order 70 FR 329 10/05/2009
12/28/2004 Final ITC Affirmative 69 FR 77779 10/05/2009
11/17/2004 Final DOC Affirmative 69 FR 67313 10/05/2009
09/09/2004 Amended Prelim DOC Affirmative 69 FR 55643 10/05/2009
08/05/2004 Amended Prelim DOC Affirmative 69 FR 47417 10/05/2009
06/24/2004 Prelim DOC Affirmative 69 FR 35312 10/05/2009
01/28/2004 Prelim ITC Affirmative 69 FR 4178 10/05/2009
12/17/2003 Initiation 68 FR 70228 10/05/2009

12.Select the B/C (bond/cash) sub-tab to view whether the Import Administration
will allow a bond or cash with respect to deposit rates on the entry summary.
The “B/C” sub-tab displays the following information:

« “Eff Date” The effective date of the bond/cash indicator.

“Bond/Cash”: The bond/cash indicator.

e “Added Date”: The date the B/C indicator was added.

« ‘“Inactivated Date”: The date the B/C indicator was inactivated.

o A “Print View” hyperlink is also available with the option to save or
print. See the section in this document titled, “Printing an AD/CVD

”
Case.

Rates Events B/C AR Parties HTS 2 Susp ES

e _Print View
Showing 1 - Sof §
Eff Date Bond/Cash Added Date Inactivated

Date

10/28/2002 Cash Only 10/28/2002
01/07/2002 Bond or Cash 10/28/2002
11/16/19%4 Cash Only 10/28/2002
04/12/1994 Bond or Cash 10/28/2002
02/28/1994 MN/A 10/28/2002

13.Select the AR sub-tab to view the Administrative Review Periods of the
AD/CVD case. During these Periods of Review (POR), the Import
Administration reviews transactions pertaining to the AD/CVD case and
provides its findings. There can be multiple PORs and each POR is usually
the same date as the anniversary date of the case. The following events
occur during the POR: “Initiation,” “Prelim,” “Amended Prelim,” “Final” and
“‘“Amended Final.” The “AR” sub-tab displays the following information:
e “POR #": The period of review number.
o “Period of Review”: The start and end dates of the POR.
o “Event”: The event associated with the POR.

« “Event Eff Date”: The effective date of the event.
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e “Added Date”: The date the event was added.

« “Event FR Cite”: The Federal Register Notice cite for the event.

e “Msg #”: The message number. Select the message number
hyperlink to view the message.

e A *“Print View” hyperlink is also available with the option to save or print.
See section in this document titled, “Printing an AD/CVD Case.”

Rates Events B/C AR Parties HTS # Susp ES

= Pring Wisw
Showing L - 4 of 4
Event Eff Added Event

POR # Period of Review Event Date Date FR Cite Msg #
04 01/01/2008 - 12/31/2008 Initiation 02/26/2009 10/21/2009 74 FR 8776

Final 08/20/2009 10/21/2009 74 FR 41374
03 01/01/2007 - 12/31/2007 Prelim 02/02/2009 10/21/2009 74 FR 6372

Initiation 03/07/2008 10/21/2009 73 FR 12387

Final 08/20/2008 10/21/2009 73 FR 48162 9294204
02 01/01/2006 - 12/31/2006 Prelim 02/13/2008 10/21/2009 73 FR 8273

Initiaticn 03/07/2007 10/21/2009 72 FR 10158

Final 08/22/2007 10/21/2009 72 FR 46957
0l 06/24/2004 - 12/31/2005 Prelim 02/05/2007 10/21/2009 72 FR 6201

Initiation 02/24/2006 10/21/2009 71 FR 9519

14.Select the Parties sub-tab to view the manufacturer and foreign exporter
information associated with the AD/CVD case. For both the manufacturers
and the exporters, the ID, Name and Address will be displayed.
o A “Print View” hyperlink is also available with the option to save or
print. See section in this document titled, “Printing an AD/CVD Case.”

Rates Events B/C AR Parties HTS # Susp ES

Manufacturer Details Fareign Exporter Details
Manufacturer ID: CHNTANCO170LON Foreign Exporter ID: XOEXOFURLLIFMON

Manufacturer Name: T. Tang & Ceo., Ltd. Foreign Exporter Name: Exotic Furniture, Inc.
Manufacturer Address Foreign Exporter Address

Street Address: No. 170, Zhen Xing Rd., Long Kou, Shan Dong, China Street Address: 255 Attwell Drive

City: Lomg Kou City: Montreal

2ip/Postal Code: 265700 Zip/Postal Code: H1E 144

Country: CN - CHINA{MAINLAND) Country: ¥Q - Canada - QUEBEC

15.Select the HTS # sub-tab to display the HTS numbers associated with the
AD/CVD case. The HTS # sub-tab displays the following information:

“HTS #”: The HTS number of the merchandise associated with the
AD/CVD case.

e “Added Date”: The date the HTS number was added.

e ‘“Inactivated Date”: The date the HTS number was inactivated.

o A “Print View” hyperlink is also available with the option to save or
print. See section in this document titled, “Printing an AD/CVD Case.”
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Rates Events B/C AR Parties HIS# SuspES

HIS # Added Date inmcEimied

Date
7009.92.1000 10/05/2009
7009.92.5000 10/05/2009
$403.50.9040 10/05/2009
9403.50.9080 10/05/2009
9403.60.8080 10/05/2009
$403.90.7000 10/05/2009

16. Select the Susp ES sub-tab to view a chronological list of all of the
suspended entry summary indicators associated with the AD/CVD case. The
“Susp ES” sub-tab displays the following information:

“Eff Date”. The effective date.

e “Suspend ES”: The date the suspension of entry summaries was
either started or stopped.

o “Added Date”: The date the suspension was added.

o ‘“Inactivated Date”: The date the suspension was inactivated.

o A "Print View” hyperlink is also available with the option to save or
print. See section in this document titled, “Printing an AD/CVD Case.”

Rates Ewvents BfC AR Parties HIS 2 Susp ES

b Print View
Showng 1 -6 af &
Eff Date Suspend ES Added Date L’;’I:“"‘“"'
10/28/2009 Start 11/04/2003 11/05/2009
09/01/2009 Start 11/05/2009
08/20/2008 Stop 10/20/2009
12/28/2004 Start 10/20/2009
12/20/2004 Stop 10/20,/2009
06/24/2004 Start 10/20/2008

The” Task Selector “portlet contains the “Company Details” hyperlink which allows
you to return to the last previously displayed case search.

If you navigate away from a search results screen and then want to return to the
case, simply select the Company Details hyperlink and ACE displays the results of
the last case search.

—

| ce—
Home [ Accounts m Tools | @ EI
Task Selector 7 | Search AD/CVD Cases Tm
Select Tagk v}~ Search AD/CVD Case
HTS Case #: Company Status: | ..Salect-- vl
Tariff History 1 i 1
e Country: = R ] Short Description:
Port ry Select >
Gold Rate HTS #:
Currency
Qurrgncy Exchange Party Name:
Goyntry Code
MID Party ID:
UN Loc Code
*  AD/CVD Cases Search - @ @
> Company Details B
AD/CVD Mess Search -
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Once a case displays, the trade also has the option to select the Messages
hyperlink, located in the “Task Selector” portlet to view any messages associated
with the displayed case.

Select Task

|| Company Header DOC-TA Contact
HIS Case #: A-570-506-000 Contact Office:
Tariff Higtory Create Date: 09/15/2009 Contact Name: Custams Unit
Port Related Case #: Contact Telephone #£1: 202-482-0384 Ext:
Gold Rate Country: CN - CHINA(MAINLAND) Contact Telephone £2: 202-482-3577 Ext:
Currency Exchangs Short Description: PORCELAIN-ON-STEEL COOKWARE
Coyntry Code View Official Case Name
w_o_ Status: Active
N Loc Code Suspend ES: Yes
ADCV] Search e
> Company Details +|| Rates Events B/C AR Partics HIS# Susp ES
—# Heszagez, sl Print View

View AD/CVD Company Case

Messages
Case #: A-570-891-015

Message Message Tyvpe/ oy =
o Status Dats SubType POR Message Title (RE:)

Printing an AD/CVD Case

1. Select the Print View hyperlink.
2. A pop-up window will display with the “Company Header,” the “DOC-IA
Contact” and the sub-tab selected.

e |Edt yew Favortes Toos e

s 1
&, e ﬂ E’: | I seth gerevoes £ | L- m ov | el 3
Agddress | 8] hitps:/face.tm, tnc.ace, cbp, dhs. gov/ace 1 wps PA_1_MQHSULS 1005PCOISICONGCO000 friews fcases /companyCase forintViews Com :| Go Links | @ Snaglt ﬂ
Company Header DOC-TA Contact
Case #: A-570-891-015 Contact Office: Group 3, Office 9
Create Date: 10/21/2009 Contact Name: Customs Unit
Related Case #: Contact Telephone £1: 202-4382-0984 Ext:
Coumtry: CH - CHINA{MAINLAND) Contact Telephone #2: 202-432-3577 Ext:
Short Description: Wooden Bedroom Furniture
Status: Active
Suspend ES: Yes

Period of Review
Showing 1 - 3 of 3

Ewvent Eff Added Event

POR 2 Period of Review Event Date Date FR Cite Msg &
04 01/01/2008 - 12/31/2008 Mo Review Conducted 10/21/2009 9294203

Final 08/20/2009 10/21/2009 74 FR 41374
03 01/01/2007 - 12/31/2007 Prelim 02/02/2009 10/21/2009 74 FR 6372

Initiation 03/07/2008 10/21/2009 73 FR 12387
o2 Final 08/20/2008 10/21/2009 73 FR 49162 9294201
M‘éi 01/01/2006 - 12/31/2006 Pralim 02/13/2008 10/21/2009 73 FR 8273

Imitiation 03/07/2007 10/21/2009 72 FR 10158

3. Select File then select Print to print the screen displayed. A print pop-up
window will display.

Providing the Right Information to the Right People at the Right Time and Place
11 February 2012



Topic: AD/CVD Cases & Messages

4. Accept the printer default or choose a printer from the drop-down menu to
print the screen displayed.
5. Select the Print button to print.

2 Print 2J&3|
General Options
Selact Printer
B C-35+-1HP-2420
- Microsoft Office Document Image Wiriter|
2 Snaglt 8
] [ >
Status:  Ready ] Print to file
Location:
o
Page Range
®A Number of copies: 1 -

() Pages 1 I ]I
1 z 3
Enter ether a single page number or a single _1|J_2|J_3|J

page range. For example, 5-12

et ][ Conce ]

To save the screen displayed in lieu of printing it, select File then
select Save.

Searching for an AD/CVD Message

AD/CVD messages are used by Commerce to instruct CBP to take some type of
action based on a milestone case decision. Currently the trade community accesses
CBP.gov to view public messages concerning AD/CVD cases.

This release will provide the option for users to view more detailed AD/CVD
messages through the ACE Secure Data Portal (“Portal”). All users will now be able
to search for and display AD/CVD case messages via the Portal. AD/CVD case
messages are located under the “References” tab.

! p—
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To search for an AD/CVD case:
1. Select the References tab
Select Task |
Ls HTS
Tariff History
pc—rt
Gold Rate
Currency Exchange
Country Code
MID
UN Loc Code
AD/CVD Cases Search -
AD/CVD Messages Search

A

2. Select AD/CVD Messages Search in the “Task Selector” portlet. The
“Search AD/CVD Messages” portlet displays.

3. Enter at least two search criteria in the “Search AD/CVD Messages” portlet.
To search for an AD/CVD message when the case number is not known, you
must enter at least two of the following criteria:

e “Message #”: Enter the message number or a minimum of four
characters followed by an asterisk to perform a wildcard search on the
message number.

o “Message Type”: Select the message type from the drop-down menu
(e.g., “ARF,” “INF,” etc.) See Appendix A for a complete list of
message types.

o “Message Subtype”: Select the message subtype from the drop-down
menu (e.g., “TRO — Temp Rest Order”). The message subtype will
vary depending on the message type.

e “Message Status”: Select either “active” or” inactive” from the drop-
down menu.

e “Message Date (From)”: Enter the start date for the message search.
The date format is mm/dd/yyyy.

o “Message Date (To)”: Enter the end date for the message search. The
date format is mm/dd/yyyy.

e “Case #": Enter the case number or a minimum of four characters.
(e.g., A5707) followed by an asterisk to perform a wildcard search on
the case number.

e “Court #: Enter the court order number for the AD/CVD case.

o “Party ID”: Enter the party indicator for either the manufacturer or the
foreign exporter.

e “Message Title (RE)": Enter up to 30 characters of the message title or
enter at least four characters of the title to perform a search. Any
keyword matching the message title will return search results.

o “Reference Message #”: Enter another message number to view
messages that are related to the current message.
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e “POR Search Date”: Enter a date that falls within the period of review.
The date format is mm/dd/yyyy.
« “Effective Date”: Enter the effective date of the message. The date

format is mm/dd/yyyy.

“ If you know the message number, no additional criteria is required to
execute the search.
U

If “Message Date” is selected, both the “From” and “To” date must be
entered. The date range is considered to be one field. You will need
to enter another parameter before selecting the “Search” button.

4. Enter your search criteria and select the Search button. The results are
displayed at the bottom of the portlet and are sorted alphanumerically by
message number.

Search AD/CVD Messages T
Search AD/CVD Message
Message #: Court #:
Message Type: ARP-Admin Review Prelim |w | Party 1D:
Message Subtype: --Select-- v: Message Title (RE:):
Message Status: Active v: Reference Message #:
Message Date (from): = POR Search Date: —
Message Date (to): = Effective Date: ;

Case #:

(eren | (Giear)

5. The following information is displayed for the message:
o “Message #.” The message number. Message numbers are based on
the Julian calendar date and are assigned by the system.
“Status”: The status of the message (“Active” or “Inactive”).
“Message Date”: The date the message was issued.
“Type/Subtype”: The message type and subtype.
“POR”: The Period of Review date.
“Message Title (RE :)”: The message title, i.e., the text that is entered
in the “RE:” line of the email used to send the message.
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There are eight cases displayed out of a The Up (A) and Down (V) arrows next
total of eight. In this view only 10 cases will to each label are used to sort the list in
be displayed on the screen. ascending or descending order.

Search AD/CVD Messages

Search ADSCVD Message

Message #: Court #2:

Message Type: —-Select-- vl Party 1D:

Message Sublype: | ..salact-.fe| Message Title {RE:):

Message Status: Active y- Reference Message £:

Message Date (from]: = POR Search Date: =

Message Date (o) = Effective Date: =

Case #: 0=

(Giea)

Search Results
Showng 1 - B ef 8
Message Message Type/ :
# Status Date SubType POR - Message Title (RE:)
9293201 Active 10/20/2009 :‘:FE NOTICE OF PRELIMINARY DETERMINATION FOR SMALL DIAMETER, GRAPHITE ELECTRODES FROM CHINA
9303202 Active 10/20/2009 ::f NOTICE OF PRELIMINARY DETERMINATION FOR SMALL DIAMETER, GRAPHITE ELECTRODES FROM CHINA
§293203 Active 10/20/2009 ;?FE NOTICE OF FRELIMINARY DETERMINATION FOR SMALL DIAMETER, GRAFPHITE ELECTRODES FROM CHINA
Q283204 Acdive 10/20/2009 .:.:E NOTICE OF PRELIMINARY DETERMINATION FOR SMALL DIAMETER, GRAPHITE ELECTRODES FROM CHINA
9263305 Active 10/20/2009 :?FE NOTICE OF PRELIMINARY DETERMIMATION FOR SMALL DIAMETER, GRAFHITE ELECTRODES FROM CHINA
9293206 Adive 10/20/2009 i‘;‘f NOTICE OF PRELIMINARY DETERMINATION FOR SMALL DIAMETER, GRAPHITE ELECTRODES FROM CHINA
0293207 Active 10/20/2009 :D';JELII'-'I INJUNCT ON WOODEN BEDROOM FURNITURE- T. TANG & CO., LTD (CHINA) (A-570-8%0-001) CTNO 07-00313

g LIGUIDATION INSTRUCTIONS FOR WOODEN BEDROGM FURNITURE, FROM CHINA PRODUCED ANG/OR EXPORTED
2293208 Adive 10/20/2009 BY T. TANG & CO., LTD (CHINA) (A-570-890-001)

The horizontal arrows and page numbers (<< <[1] 2 3 > >>) allow the user to navigate
between pages. To go to the first or last page of the list, select the double backward
arrows (<<) or double forward arrows (>>). Selecting the single arrows advances the
user forward (>) or backward (<) a single page at a time. The user can also select a page
number ([1] 2 3) to go directly to that page, if it is displayed.

6. Select the message number to navigate to the “View AD/CVD Message”
portlet.
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View AD/CVD Message Ta=0O
Message Header
Message #: 9293208
Case #(s): A-S70.850
Reference Message #(s):
Message Title (RE:): LIQUIDATION INSTRUCTIONS FOR WOODEN BEDROOM FURNITURE,

FROM CHINA PRODUCED AND/OR EXPORTED BY T. TANG & CO., LTD
(CHIMA) (A-570-890-001)
Message Type: LIQ-Liguidation Message Status: Active

Message Subtype: ALT-Auto Liquidation Message Date: 10/20/2009
Category: Antidumping Inactive Date:

Access Type: Public Effective Date: 06242004
POR (Begin): FR Cite:

POR (End): FR Cite Date:

Period Covered (Begin): 06/24/2004 Court #:

Period Covered (End): 12/31/2005 Lifting of Suspension Date: 12/21/2007

Message Body  Companics

e Visw &g POF

1. FOR ALL SHIFMENTS OF WOODEN BEDROOM FURNITURE FROM THE PEOPLES REPUBLIC OF CHINA PRODUCED AND/OR EXPORTED BY T. TANG & CO., LTD i
{CHINA) (A-370-890-001) ENTERED, OR WITHDRAWN FROM WAREHOUSE FOR CONSUMPTION, DURING THE PERIOD 06/24/2004 THROUGH 12/31/2005, ASSESS AN
ANTIDUMPING LIABILITY OF 216.01 PERCENT OF THE ENTERED WALUE.

7. The “View AD/CVD Message” portlet displays with the “Message Header” and
two sub-tabs, “Message Body” and “Companies”. The “Message Header”
contains the following fields:

e “Message #”: The message number.

e “Case # (s)": The case number. Up to six case numbers can be
displayed.

o “Reference Message # (s)": The message number referring to other
related messages. Up to six related message numbers can be
displayed. Select the hyperlink to view related messages.

o “Message Title (RE:)": The message title, i.e., the text that is entered
in the “RE:” line of the email used to send the message.

o “Message Type”: The message type (e.g., “ARF,” “INF,” etc). See
Appendix A for a complete list of message types.

e “Message Subtype”: The message subtype associated with the
message type.

e “Category”: The category of the message (“Antidumping” or
“Countervailing”).

e “Access Type”: The access type which defaults to “Public.”

e “POR (Begin)”: The beginning date of the first “Period of Review.”

e« “POR (End)”: The end date of the first “Period of Review.”

o “Period Covered (Begin)”: The beginning date of the second “Period
of Review.”

o “Period Covered (End)”: The end date of the second “Period of
Review.”

e “Message Status”: The message status (“Active” or “Inactive”).

e “Message Date”: The system date the message was approved.

« ‘“Inactive Date”: The date the message was inactivated.
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« “Effective Date”: The effective date of the public message.

 “FR Cite”: The Federal Register Notice cite associated with the
message.

 “FR Cite Date”: The Federal Register Notice publication date.

o “Court #”: The court order number.

e “Lifting of Suspension Date”: The date the suspension was lifted.

The hyperlink on the seven digit case number will not work for trade
users. If you inadvertently select the hyperlink on the seven digit case

A number, you will navigate to the “Home” page. To return to the
“Message Header" portlet you were viewing, select the “Reference”
tab.

8. Select the Message Body sub-tab to display message information. The
“Message Body” sub-tab displays the content of the message. A maximum of
9,600 characters can be displayed in the message body.

« A*View as a PDF” hyperlink is also available and will display the
header and company information with an option to print or save.

Message Body  Companies
= \View as POF

1. FOR ALL SHIPMENTS OF WOODEN BEDROOM FURNITURE FROM THE PEOPLES REPUBLIC OF CHINA PRODUCED AND/OR EXPORTED BY T. TANG & CO., LTD |
(CHINA) (&4-570-890-001) ENTERED, OR WITHDRAWN FROM WAREHOUSE FOR CONSUMPTION, DURING THE PERIOD 06/24/2004 THROUGH 12/31/2005, ASSESS AN
ANTIDUMPING LIABILITY OF 216.01 PERCENT OF THE ENTERED VALUE.

2. NOTICE OF THE LIFTING OF SUSPENSION OF LIQUIDATION OF ENTRIES OF SUBJECT MERCHANDISE DURING THE PERIOD 06/24/2004THROUGH 12/31/2005
OCCURRED WITH THE PUBLICATION OF NOTICE OF CORRECTION TO THE SECOND AMENDED FINAL RESULTS OF ADMINISTRATIVE REVIEW, 72 FR 72674
DECEMBER 21, 2007. FOR ALL OTHER SHIPMENTS OF WOODEN BEDROOM FURNITURE FROM THE PEOFLES REPUBLIC OF CHINA YOU SHALL, UNLESS OTHEAWISE
INSTRUCTED, CONTINUE TO COLLECT CASH DEPOSITS OF ESTIMATED ANTIDUMPING DUTIES FOR THE MERCTHANDISE AT THE CURRENT RATE.

3. THE ASSESSMENT OF ANTIDUMPING DUTIES BY CUSTOMS AND BORDER PROTECTION ON ENTRIES OF THIS MERCHANDISE IS SUBJECT TO THE PROVISIONS

OF SECTION 778 OF THE TARIFF ACT OF 1930, SECTION 778 REQUIRES THAT CEBP PAY INTEREST ON OVERPAYMENTS AND ASSESS INTEREST ON

UNDERFAYMENTS OF THE REQUIRED AMOUNTS DEFOSITED AS ESTIMATED ANTIDUMPING DUTIES. THE INTEREST PROVISIONS ARE NOT APPLICABLE TO CASH OR
BONDS POSTED AS ESTIMATED ANTIDUMPING DUTIES BEFORE THE DATE OF PUSLICATION OF THE ANTIDUMPING DUTY ORDER, WHICH 1S 01/04/2005, INTEREST ¥

9. Select the Companies sub-tab to display company information associated
with the message. The following fields will be displayed:

o “Case #’: The company case number.

o “Rate”: The deposit rates used to calculate estimated antidumping
and countervailing duties.

e “Party Ind”: The party indicator (“S,” “E,” “I” or “M”) associated with
the party name.

o “Party ID”: The identification number assigned to the party.

o “Party Name”: The name of the shipper, exporter, importer or
manufacturer.

o A*“View as a PDF” hyperlink is also available and will display the
header and company information with an option to print or save.
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Message Body Companies
e View as POF
Showing 1 - 2 of 2
Case 2 Rate Lt Party ID Party Name
A-370-929-001 15964 M CNSHEHAQTOXIN Shenyang Hacsheng Carbon Co., Ltd.
A-570-925-002 90.50 M CNHORTECL3DON Horizon Tech Carben Co., Lid.

There is a new format for AD/CVD messages in ACE. Messages
migrated from ACS into ACE do not have the additional fields.
Therefore, you may see two different formats for messages in ACE.

Printing an AD/CVD Message

1. Select the View as PDF hyperlink.
2. A pop-up window will display with the requested data in a PDF format for

review before printing.

Er.\: GoTe Fawortes Hep
) x] (2]

1| | - sewech Favorites {§%) - d [ g 3
A &) hits: face.swit1.ace, oo, chs. g_p..'.-.:n‘a_LjAQMZ:-:-:-GFbJ‘.-I—:S:\'::W-.)czma:{.he.::ﬂﬁ.:r:a!t!\"ﬂm-.‘.ﬁr v .GO
= & 17 | @e s - T |l
MESSAGE NO: 9288204 MESSAGE DATE:  10/15/2009
MESSAGE STATUS:  Active CATEGORY: Countervailling
TYPE: PUBLIC NON-PUBLIC
SUB-TYPE:
FR CITE: FR CITE DATE:
REFERENCE

3. Select File then select Print to print the screen displayed. A print pop-up
window will display.
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4. Accept the printer default or choose a printer from the drop-down menu to
print the screen displayed.

5. Select the OK or Print if applicable.

Print | %]
Frovter |
hame: |Mcrosoft Office Document Image Witer | ~ | Properbes
Status: Ready Comments and Fonms:
Type:  Micresoft Office Document Image Writer Driver |-'}ucmcnm'rdl'-‘uhm :_J

Print Range Preview: Composite
- S 85

-
A

™ Current view
™ Current page - h
" Pages |1-4 -yl By O e
Sulset: [Hpagesnraﬁ;e j :-.- “-..-...

I Raverse pages

Page Handing RO Lo e UL
Copies: m r 11 S .

Page Sraling: | Shrink to Printable Area -

k3

¥ Auto-Retate and Canter

[ Choose paper source by POF page size

- N

E

[ Printto fie Units: Inches Zoom : 100%

Y4 i

To save the screen displayed in lieu of printing it, select File then
select Save.
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Additional ACE Resources
For additional assistance, take the web-based training (WBT) titled “Forms,
Declarations, & AD/CVD Cases.”

The URL for the ACE Online Training @

Center and the required user name A

and password are: ACE Web-based Training (WBT) You can launch & courss tram tha links below:
SETRLELINSL S actinmaliegni /()

oo g, sl Wi e ACE gl

http://nemo.cbp.gov/ace_online Sty o s e oo PoriodigBapments  [(30)
Iry Sarsa few Imbieshooing ligg e
:::,: :'._:::::IIE;_-:! :.Elfm o e-Manifest:iTrucks @
Browser name: Mcrcantt Estemet Exploser
— . e e-Manifiesto: Camiones @
Forms,Declarations, & A@@ P T g i i i gl
- o et N M eLsbent version of Flash iy TN (o ihe Trade
AD/CVDCasesl B ARommsninee adERREE YD)

Enhanced ACE Arcounts

ot MasteE Dis A
it Modal I'iulllI-l.l and

SRR nhanemy munts

Ferms, [l?gm:u'.ﬁ:u_ B
ADVEVEEases

Do you need additional assistance with Managing Cross Account
Access? If you are a trade member calling or if you are calling outside the
United States, please contact Technology Service Desk at 1-866-530-4172.
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Appendix A: Message Types

ARF — Admin Review Final
ARP — Admin Review Prelim
ENF — Enforcement

FIN — Final Determination
FNO - Final Det w/Order
INF — Information Notice

INI — Initiation of Review
INJ — Injunction

INQ — Inquiry

LIQ — Liquidation

NSR — New Shipper Review
ORD - Order

OTH - Other

PRE- Preliminary

REV — Revocation

SCO — Scope

TER — Termination Notice
WRIT — Writ of Mandamus
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